EOEELUE IS

Az EAAN PRI P ALES N F I — A EFIH, SHEE CoppeliaSim HH i & — ALK
B IARIAESS, R IR BE 3k % 2] S5 1 Actor-Critic (Soft Actor-Critic, SAC) ZfRIRE .
SIS 53 e s AN [F) 22 Jah R B RO, FH DLERUE 4 B 25 S 32 It T e SR AL 28 AN HIUBUAE: 55 1) B 22
Pho FEARTARRE, FATERNLE N7 IR BRI S TR A AR AL 25 A 5 2100 H A&
HEAT TR B 18

R EESRAL S 2] B IR 208 AE LSt SN 355, HLAS N3l 3 b b & AN IR 11 4k
o BRI 2 FE T A RN AR I Mg TR A K 22 BT BRI TR, AR T/ 4] OpenAl
Gym AEESE, FRATTH A8 A e 191 2 IR B2 A 2 2] TPV AE HIL A N5 ) 0 e 58 4 B AL Ge 45 1 77
%, iz (Inverse Kinematics) 8% 7-F14>-14> (Proportional - Integral - Derivative,
PID) #5Hil%. SR, IREERRMS: ST ReM N T HE2e BARNS T, 1 9 515 etz AR 4AE ) 772,
NEEN T HEE R ARG uE RIEHEIET 4 (Akkaya et al., 2019; Andrychowicz et al., 2018).

AR ZHAGOUT, HLas NG v DUH SRR (Markov) I FARBF T fBL, 3X
156 BONTR BE s Al 2 ST R AN B S 1 — AN BRAE RS0 . A Ak, R BRALSE ST X T ISt
FApLas N B B 1 5] T ¥ 214 DeepMind F1 OpenAl %5 = RHY 2 5] SR BN IX AN 5
Mg, oK, OpenAl &l HaEEENL (Automatic Domain Randomization) $5 A SR i 1 A5E
B SEMIEH (Sim-to-Real Transfer) [Al@, M — AT FIRHUE fE R T Rubik BT, W
Bl 16.1 for. HAt 2w M IFERAT A8 H B an e e im0 B8 o0 RAE 55 BB, 2
B2 ATEI St S Il 5 (Korenkevych et al., 2019).

SR, B TR oAk 22 o) B E R B T ISt S A SRR R AR A e P I e, AATT R
I BB AE I S Sl R Ak 5 =) SRS SR D B IR LA N R G 45 il BUR TG R 424 55 (Akkaya
etal., 2019) & WHER) o FEBLAIREE th il 255 76 B J5 1 SR Fe B P St 5, s R AR LK

388



16.1  HLE AL L

161 FA—NEF MR RbK B ANB R, B K% B SCHk (Akkaya etal, 2019) ( ¥ HE )

ff)7~ 78 (Human Expert Demonstrations) K%, #2710 LA N5 S i B R A2
AERITT . MBS NS 8 KR 7314, % DART. CoppeliaSim (ff 3.6.2 liA 2
AIMY{E V-REP) (Rohmer et al., 2013). MuJoCo. Gazebo 5. TEARF &G —/NIEHHKITIE. K
T NATIASE PR B2 s Ak o S s ) S A A B PR, IR eI R 2 BT Python X M RRCAS o

TERAUAR S 2 2] 2 /DE AN T A B X o B—, BHUIREEa] DU AR B i H R BHE 42 i
o CEFREAIR T oR il 22 )8, JCHR R I SEtH SN A, el #s N2 SIE 55 . 78
BRI 2 2] 0] DAE 7 77 VA8 B B Sl S i B iE i f o 36 —, o Tramad A 3 L S it
FE I 7 AR I St F i) AR, AEABLAUL b 2% ST AN W BER IR — 25, AT DAY/ D )R] T FE AN
B EE

FEIX— 5, FRATKG S AR AER 2 5 A 2 S0 5002 31— AN BLADL PR 58 o 17 B (R LA AP AR AU
S e, # ] CoppeliaSim (V-REP) #5428 F1'e ) Python %% : PyRep (James et al., 2019a). F;
AITFUE T IXANIH BAF 55t AR P R A 2 ) SR AR SRARAG Y, 3 T35 2 S P f

HTZH SN E 7 — SRR SIS H T R 4 R 2L ] i N, AT LS N
SR 55K BE N g B S B b iR A 2 Y AR A 7 T, 04 G AR R S — A B E e R A o o SRR TE AT 5%
READIRSG , ] B vk 22 ol R BOR S B AL 7 S S B 4 AT 55 B ARSE, DAGS L SR pibxf i %
ST ERAE, AR T INGERE, BAE T it % I 35 .

16.1 #l=3 A=H

TAVH P EMI R B MRS, BFG: —/MUE . SPE B — . X
AMEUFA B AT IS B A A . ART, X BIRATE RN — i, — DRI A SRS
FEIX AT o 2 > 3 (10 SR gt m] DA B AE LS b US4 (R B — > “ JSER 7 BEUA

VR LB ST
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55 A] DLd kAN 5] ) BT s, T H e R A — Rl AT B S bR I St SO DTS . 2645 ok
Ui, ANFEDGRSEAE T EYA = AR RO, X e rT ge i d R AR < Jse”, (Hag A
A Ho— PR BRI SR R 4, 1 L IR 0 8 X 4% () U, X R A b R 4R 22 S T e S
SE R A FIIEIE . S8 T R OX AR RIS A2 i A 1 0 R, a3k B A4 (Domain
Randomization). ) /J2£BHL1E (Dynamics Randomization) Z5¥F% J7 ik AN Y, FRAT TR
AT AT R DE .

WAEE 2 ML N ES , f4E CoppeliaSim ( V-REP). MuJoCo. Unity % . iR iz CoppeliaSim
(V-REP) #Af# ] C++ Al Lua if & CReR@ A B O, 11 R A &6 5 sR £ s v] LUE I Python SE3.
SR, 0T R EE SR AL 2SI T & Bl Python #2111, 3232952, FRATH PyRep BSR4
CoppeliaSim (V-REP) A TIRFEENLEE N2 FEALUH F1, A1 A CoppeliaSim (V-REP) Jf#4
e & F A4 PyRep K1 Python 42 .

BAVEAEARNT R B E — M NS TS AT R .

%% CoppeliaSim 1 PyRep

CoppeliaSim ( V-REP) ¥ {14 7] DAZE B W2 R 2 3, ME A B SR b, 41175 2 CoppeliaSim
(V-REP) [1]3.6.2 A (A]LATEMG3 B3R E]) SKER PyRep FE4¥ . & W] ULE B2l i K T 2k S
Kk, ST CoppeliaSim (V-REP) 3.6.2 HRRA AT GERRIX AT H A HAR AR H A 3 25

‘%458 CoppeliaSim (V-REP) 2 J&, FATAI L@ PR JUA 2 e A 1 Bl Cik % WLise
R4 LERI—A PyRep M4 X Fa g A :

git clone https://github.com/deep-reinforcement-learning-book/PyRep.git
pip3 install -r requirements.txt

python3 setup.py install --user

# ER: EUTHEATEFERRER NP A VREP KR E

export VREP_ROOT=EDIT/ME/PATH/TO/V-REP/INSTALL/DIR

export LD_LIBRARY_PATH=$LD_LIBRARY_PATH: $VREP_ROOT

export QT_QPA_PLATFORM_PLUGIN_PATH=$VREP_ROOT

source~/.bashrc

JefREnt FR A H ) VREP_ROOT ¥4 V-REP [HE&4% .

Git TEARINE
R FE R SR AL 2 SR N AR N ST ST H AT LUEE L R a4 T3k

R WL IS5
SR WL I 55
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git clone https://github.com/deep-reinforcement-learning-book/Chapter16-Robot-Learning

-in-Simulation.git

XA H S LA AR B, e ED AR IRATH Z YR @RI AL S 1S
St RN B8 fA 42 1) SHEMS PRI B2 oA 27 ) 0055 o AT H P gL A IR 51 LI 16.2.
FATHFAE LUT JL/AN o R e R S A 5 S AR 2 il 0 23 R 5

162 CoppeliaSim (V-REP) thEHIER ( Grasping ) E&H5 ( ¥ )

HIEIB/A

FAEEH 4N Rethink Sawyer WINIARE F1—A~ BraxterGripper 53¢ B . B 77 PyRep A8
PRAE T Z AR A1, AT LA SRS A AR BT 53 5. FRATIX ARt — A7, 4%
—NRAZREBINNE, WK 16.3 Fixs.

AT Git 4R, ¥ ./hands/BaxterGripper.ttm fll./arms/Sawyer.ttm #i A\ 7E Cop-
peliaSim (V-REP) HITHP— Mg 5. JANEFEIEIHFI 4% Col AR o 8 &7 Sawyer [
K55 (Bl Sawyer_wrist_connector, ‘& & CoppeliaSim (V-REP) HHI—A & E2%, AILL
T EBEARFEDA, RGeS %7 %4, WK 16.4 Fizk. CoppeliaSim (V-REP) #2447 AS[A
FRRMERRS, X LRSS R —F, X s W 2 B M 1L )R T — A BIME
AR A BRI AT Be . S — 5T, FRATARAZAEIX A “4HG6/6 7 (group/merge) ETI, XA
T REME ML A e AN o B2 O T W B AV A A R AR (R 48 5 BT LA [ CoppeliaSim
(V-REP) ik, fERATEHEL B fE, Friads M )/=4% (Scene hierarchy) M 41 16.5
FiR o
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163 Sawyer Y& Rifs ( 22 ) F04H %895k & BaxterGripper ( A ) ( WFAE )

gns Addons Scenes Help
e als?
|

g> @1 Enj), HY

164  CoppeliaSim (V-REP) th#y “4H3" (‘assemble ) #21H

W35 SR

16.2 J&7~ T CoppeliaSim (V-REP) H— /MU HI%5:, MINCH N . /scenes/sawyer_
reacher_rl.ttt. N [ WHEXAHEAY 5, AT ZEAEHARY AR IR 2417 268 HUbkE ke
Algsit

B, BATELRM (Add) -> B8R (Primitive shape) -> K 751K (Cuboid) #in—4
Hirpik, WSO RNBER RS IR E a4y “His”. JATHERS “HER” A7 i b
HikPE Nt (Common) ->A[IEZRH] (Renderable) KAWL b AL B2 1T UL o

VL FAPRZ G, FRATTER BN — AT DLAS FRAT 3R A 5 i 37 s ML I A A 2% o XA R
A& S AT DL RS R o — B B I B, SRFRA 1 B T R A ], IR A X A v A%
TR LT CRARET BB IS, FRATTRA TR EE) . mREAES =P B XA
WA KA, AT DIERPL R — PR EEE . AT WERXEN S, BdERm (Add) -> 5
{£RLEE (Vision sensor) -> L FAAEE! (perspective type), ARG HEHR TR, ®ERM (Add)
-> FBIALEF (Floating view). XN 56 B JATHINI G2 R To R BRER, SR )5 4 B s 4T JT K 3)
B, EFEAE (View) -> XKBXMEMEIRFERM 552 (associate view with selected vision
sensor). Pfif5, AT B E AL AL AR 10 A7 B AL M R, 1921w 16.6 st st.

N, FATAIHE SR . Jobjects FHEAME A table. ttt. @I B E4A (Object) /
YImi%ah (item shift) %8, AT E XA RENME 16BN B AR KT &, 515
EA =T B, Wi 167 fos.
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L2 AFE L

Scene hierarchy
@ sawyer_reacher fiscena 4) (= [l
& DefaultCamera
target
B o- ¥ diningTahkle
| & diningTable_visible
EHo- & ResizableFloor_5_25 4
B e- & Defaultlights
B e- & XvyZCameraProxy
Bo- G Sawyer & [l
A Sawyer_linkl_visible
& Sawyer_target
B & Sawyer jointl
B— @ Sawyer linkl
@] Sawyer_link] _wvisible
=] § Sawyer_headJaoint
B @ Sawyer head

B m Sawnyer_head_wisible
&r Sawyer_head_camera

B & Sawyer_joint2
B— @ Sawyer link2

m Sawnyer_link?_visible

B & Sowyer joint3
BH— @@ Sawyer_link3

A Sawver linkd visible
B & Sawyer jnintd
O @ Sawyer_linkd
Sawyer_linkd_visible
B & Sawyer joints
B-— @ Sawyer links
a} Sawwer_linki_visible
B & Sawver_jointé
BE— @ Sawyer links
(_‘E} Sawnyer_linkB_visible
B & Sawyer_joint?
B @ Sawyer_link?

B

=

A Sawnyer link?_visible
& Sawyver_wristCamera

Sawnyer_wrist_connectar

Ho (D BaderGripper = Ul

[x

165 CoppeliaSim (V-REP) #ESHRHELR, BIE Sawyer TIMETEAN NI EYIBERE, 46

kR AT SRR R 05524

FARR R I E I

coord. ] [+1.40000+00 | | ApplyX tosel
Yeoord.[m]  [+7.4506205 | | ApplyYtosel
Zeoord.[m]  [+1.65500400 | | ApplyZtosel

BFRERTHFPITRNYIE, mKE

B 166 £ CoppeliaSim (V-REP) X B niff Ek2s, ZEMNEFREEVNE, AERAFTEHLE
AN/NFOEHAMENHEYER N, WRXRAETEGOZFIREFFABEN, B4

TG NETRERGURE ( LEE)
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B’ 167 FxhkE CoppeliaSim (V-REP) h¥AMIRIE ( LFHE )

VA E R B SR, XN RERATRME 7RSS P LG B Sk IX LSk 1) 5)
D15 R TP AU S B RBAD A o PRtz A, FRATTIE 7R 245 AE IR rh o XA AR A 22 )
PR3 (Reward Functions), 8% 4GV FE SN MBREI &1 (FERIBHEMES). — Mg B
(Episode) HJJFE MZE AP IR, HIda4b 511 MR ERTEASE. EIRATN Gie STfFr, FRAT52 4t
T =4 sawyer_grasp_env_boundingbox.py HK{EG srh L HlIX L ThiE, A THETZEMN
Hsatb2s 2 Fkadb AT 4], X AMEATRA TR S OpenAl Gym HIEAHAN N TR 71T (APIs).
A AR AR B R Eas ), XA fl AT DA SR 3 ) S R ose (B T
B2 PSL B ) o TS AIIBUESS, BAUEH ERiE3) % (EEEH TS
B FE AL RIS « AT A FIECE 7 Ul 1 — NI 738 3 7 e
Bl GRS Zomii B B35, RIS 3245 08 5 75 2R — AN IR T M BRI LR E o
FALERRMMERTEL (Jacobian) FEFEMIY, XNTIEELE PyRep A LK. KT XAz
SV B WA A B . AT AL 7 F2 7 B IR 2 3 72 R AL A5 AT DA
SCRE A b P s il AL

W SR, SRS B CRIALES NS B A 5] ) 2 A 2 v AT URRE (B i, AR
LN O AN R BE R  ALP AK S £ . 1X 5 CoppeliaSim (V-REP) B {Fx 2 25 A1
FRSAAE (RN 255 Sawyer_tip s& — MRS K —RERA K. MHTSHEETT
P 3t 4

fE CoppeliaSim (V-REP) M X Bif il 52 f5, WATHTEH PyRep M5 — 4N 5E LA
i)y 750 R AN 2L ) R B ) A AR . AT G EE R A T SCASR IR . R LAN T R
AT A ZE 5T H e FH 20 1) R R

MBI P R iR R

AT R OIFRE T EN 2R,

S 3 WL IS5
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from
from
from
from
from
from
from
from

from

os.path import dirname, join, abspath

pyrep
pyrep
pyrep

pyrep.
pyrep.
pyrep.
pyrep.
pyrep.

import PyRep

.robots.arms.sawyer import Sawyer

.robots.end_effectors.baxter_gripper import BaxterGripper

objects.proximity_sensor import ProximitySensor
objects.vision_sensor import VisionSensor
objects.shape import Shape

objects.dummy import Dummy

const import JointType, JointMode

import numpy as np

import matplotlib.pyplot as plt

import math

POS_MIN, POS_MAX = [0.1, -0.3, 1.1, [0.45, 0.3, 1.] # HFEYEEHLELE

FEJE SR RIT A4

JIRE LS NATUBUE 55 IS 8 AR G5 B i T o X BLITA () e R AE R R 5, FRATTRE

class GraspEnv(object):
# Sawyer HL#& AJEUYH

def __init__(self, headless, control_mode=’joint_velocity’):

# 5

#:

# :headless: bool, #W# X True, &&FMA; & NA A

# :control_mode: str, ’end_position’ = ’'joint_velocity’

def _get_state(self):

# B

B L4 % 1 A B SR B A B AR B B A

def _is_holding(self):

# iR

EMAEAT 5 T HKA, # bool

def _move(self, action, bounding_offset=0.15, step_factor=0.2, max_itr=20,

max_error=0.05, rotation_norm =5.):
# * T’ end_position’ #R, FARFEEZIHFRBAEL S K. K FEsNFHEREF ZE TR
# B Rom EARREZIE, WAEFEA solve_ik() HEk, [F ¥HE solve_ik() H# A fE E# T1F
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# A HIRLFHER], EAR Rz

# S

# :bounding_offset: AR EMNMEREIWAF TEFTANRE E, EHERELZ 2 EHE
# JLHE

# :step_factor: /NFKET, ARFULGHLEMCENRZ, BIEIERBGRAET

# max_itr: wmAMIEARKE

# :max_error: HREANMEHEHREEZNEAF

# :rotation_norm: fRFT— i AEENE T, aTHESENEERERNETLE, A
# EHEHIME

def reinit(self):
# EHAMHNIE, i Gk B AR R P A A A

def reset(self, random_target=False):
# EEXEMEMAAMTE

def step(self, action):
# REHELANME: wREREX A’ joint_velocity’, WFHERE 7 WA THEEE +1
# BRI K EEHE; WwREFER A end_position’, NWHER 3 ERE WLWEW® L LF
# +1 EXRERHEE

def shutdown(self):
# RABEIE

BB RAGAIE, B EIHARR, I __init__ O RETE L —F:

396

def __init__(self, headless, control_mode=’joint_velocity’):
# B
# :headless: bool, # % True, N&&HFAMA,; & WA A

# :control mode: str, ’end_position’ = ’joint_velocity’

# WENALE



16.1  HLE AL L

self.headless = headless # % headless # True, |7 ¥ #1
self.reward_offset = 10.0 # I Z| 4Ky % 5 &
self.reward_range = self.reward_offset # X Jfjff#
self.penalty_offset = 1. # A &L X ABEHIHETE
self.fall _down_offset = 0.1 # Fl TH WA EELBNESE
self.metadata=[] # gym 13 54
self.control_mode = control_mode

# MMEIEH A end_position’ =’ joint_velocity’

BRAL __init__Q MR R BOEMB SIS, I E R PR R AR AL

self.pr = PyRep() # #Jf PyRep
if control_mode == ’end_position’: # P77 7 # LLR 35 2 5 iy 77 A #EAT B (o B 42 | 2 5
SCENE_FILE = join(dirname(abspath(__file__)),
' ./scenes/sawyer_reacher_rl_new_ik.ttt’) # & K mizs¥ =605
elif control_mode == ’joint_velocity’: # FT& % #FLLIE M2 00 /1 B /7 45 77 S HEAT 89
# M E IR
SCENE_FILE = join(dirname(abspath(__file__)),
’./scenes/sawyer_reacher_rl_new.ttt’) # £ /5 If HiZ3) ¥ EH 837 =
self.pr.launch(SCENE_FILE, headless=headless) # & #/3% %, headless &E*k#& /7 1L
self.pr.start() # BEITE
self.agent = Sawyer() # 752|377 & ey HLM &
self.gripper = BaxterGripper() # 2|37 & F#1 % A
self.gripper_left_pad = Shape(’BaxterGripper_leftPad’) # 3t H Fi5 oA
self.proximity_sensor = ProximitySensor(’BaxterGripper_attachProxSensor’)
# ERELH
self.vision_sensor = VisionSensor(’Vision_sensor’) # f&/& 2 4
self.table = Shape(’diningTable’) # ¥ EH 2T, Fkib EaE
if control_mode == ’end_position’: # i i HLAKE 3 &L E RS ) F R R ALEE
self.agent.set_control_loop_enabled(True) # #& & False, N [AiZ71% Tk T1E
self.action_space = np.zeros(4)
#3 BEEWSRELEEH M 1 8dENKAEjEEEF
elif control_mode == ’joint_velocity’:
# B EBERE S X THEE KA I FZ ¥ EF AR E
self.agent.set_control_loop_enabled(False)
self.action_space = np.zeros(7)
#7 BHEREES, TAFSEFneiess, £ 7 MATERE

else:
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raise NotImplementedError
self.observation_space = np.zeros(17) # 7 N AT E L EMFEHE +3 FHMNTE
self.agent.set_motor_locked_at_zero_velocity(True)
self.target = Shape(’target’) # 15 %| Hir4yik
self.agent_ee_tip = self.agent.get_tip(Q)

# WARE Rom iy — AN E4, E A R 1A 35 3 5 12 ) 8 0 R o ok 24T 5 4
self.tip_target = Dummy(’Sawyer_target’) # =it (HLAE 893 &) E5)H AR &
self.tip_pos = self.agent_ee_tip.get_position() # &7 x, y, z (L&

BREL __init__Q MU =E R B AE MR PLEE N LB AR s E -

if control_mode == ’end_position’:
initial_pos = [0.3, 0.1, 0.9]
self.tip_target.set_position(initial_pos) # % & HAr{I &
# ek RS EH R LA LK E reset_dynamics=True gzt 7 LBk & i 4 A
self.tip_target.set_orientation([0,np.pi,np.pi/2], reset_dynamics=True)
# MANEE x oy EEEEXRAEET
self.initial_tip_positions = self.initial_target_positions = initial_pos
elif control_mode == ’joint_velocity’:
self.initial_joint_positions = [0.0, -1.4, 0.7, 2.5, 3.0, -0.5, 4.1]
# — A NATIE A
self.agent.set_joint_positions(self.initial_joint_positions)
self.pr.step(Q)

WIF A2 — DR WERE I R, AR BRI, DU H AR R =425 AL E
Mt 17 4k

def _get_state(self):
# REEIE XA E S E R E AR E AR A

return np.array(self.agent.get_joint_positions() + # list, ZE#H 7
self.agent.get_joint_velocities() + # list, 4% 4 7
self.target.get_position()) # list, E#H W 3

N E I B B ANE A R B E N _is_holding (), i e BB b AL Ao N
AL PR B AR AR R e M A FE TR AE AL

def _is_holding(self):
# BEBEHTE THRA, # bool
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# ERAMERNCEEEHY, FTESEMBO, e G40 4~5 WS LI A2

pad_collide_object = self.gripper_left_pad.check_collision(self.target)

if pad_collide_object and self.proximity_sensor.is_detected(self.target)==True:
return True

else:

return False

PRAL _move O WJ LAFEAT R4V Bl PNl 3 e 7 3 2l 2 M s HR P RS S LW A AT 4% - PyRep
H AT DAH S AE AL AR S T8 B — R RSB LU AL B A3 R I AT 2%, R E R B E X
AR AL BEATER f . WARIAH] pr.stepO) BREL ABASE PyRep HHLIRE X5 1 R i
AP AT LA R . T A BOOP K I T RERAKE Y, X B IA TR A A 1
RiABIB BN R — R IVNE KB, FERM— M SRS AN R A B A S BB A PR K
PATIREE NP KB

def _move(self, action, bounding_offset=0.15, step_factor=0.2, max_itr=20,

max_error=0.05, rotation_norm =5.):

# % T’end_position’ #X, ARHEZHFRFEAELS Kom. REIDHFHEAEH2HE LR
# BRI ENEZIAN, WMEEA solve_ik() H¥k, FEHHH solve_ik() HHK T &b IE#

# T1F,

# B AFXLBIESR, EAREEHF

# 54

# :bounding_offset: HHMEMNMMLERBE/IWLRFTEFANRE R, AR EL20NHE
# YL HE

# :step_factor: /NFKETF, ARFULSHLEMEFTCENRZ, BIENERHLAET
# max_itr: WABIZERKEK

# :max_error: HREARBHEFRZN LR

# :rotation_norm: Mk fhietAEENET, aTHESE N EERHERENETRE,

# AETEISINE

pos=self.gripper.get_position()

# RERSIAEESELTTEN, HE, WEHED,; TUNHET2BHIAT ZEEH
# xmin < x < x_max H y_min <y < ymax H z > z_min
if pos[0]+action[®]>POS_MIN[0®]-bounding_offset and
pos[0®]+action[®]<POS_MAX[0]+bounding_offset \
and pos[1]+action[1] > POS_MIN[1]-bounding_offset and pos[l]+action[1] <
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POS_MAX[1]+2*bounding_offset \
and pos[2]+action[2] > POS_MIN[2]-2*bounding_offset: # z A ARHEE

# WKE) set_orientation() 1 get_orientation() Z [FH —4EEEI,
# set_orientation() F# (x, y, z) X get_orientation() F# (y, x, -z)
ori_z=-self.agent_ee_tip.get_orientation()[2]

# BEZHE AN set_orientation() 5 get_orientation() Z J& H4E L
target_pos = np.array(self.agent_ee_tip.get_position())+np.array(action[:3])
diff=1 # 441t
itr=0
while np.sum(np.abs(diff))>max_error and itr<max_itr:

itr+=1

# I/ REBK(CE

cur_pos = self.agent_ee_tip.get_position()

diff=target_pos-cur_pos # Yr[frEMEFCE =R, JH(TH A

pos = cur_pos+step_factor*diff

# RELAZRE—/NF, Wik K2 % Tk K
self.tip_target.set_position(pos.tolist())
self.pr.step() # SR EE R EARE, FIHAENS kLI

# Xz FEREE RSN, ERHTREZHFRKBENER, FULEFENMNRE
ori_z+=rotation_norm*action[3]

# T hE R, [ Oy A R o e s A L R B B 1R TR B R — R
self.tip_target.set_orientation([®, np.pi, ori_z])

# FHREFTIHIE z iEs ori_z
self.pr.step() # =l

else:

print("Potential Movement Out of the Bounding Box!")

pass # WRBHEZHEL T AR FTIE, HEFLHAT

KGR A ATLLEE A A 5 e A

def reinit(self):
# EHAENIE, thhn Yk B AR R BRI A v A
self.shutdown() # & % % L] 7357
self.__init__(self.headless) # LL#H[E#Y headless R #H T4k
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IR A RENE B 5 R B AR AR AU 1B 2

def reset(self, random_target=False):

# BEERAMEMEBNME

# WE EHAr A
if random_target: # [EAL{k
pos = list(np.random.uniform(POS_MIN, POS_MAX)) # M &3 E ¥ 5] 447 & X
self.target.set_position(pos) # [EHL{LE
else: # AL
self.target.set_position(self.initial_target_positions) # [E =L &
self.target.set_orientation([0,0,0])
self.pr.step()

# EARMEEREFMSLE
if self.control_mode == ’end_position’: # JointMode.IK
self.agent.set_control_loop_enabled(True) # /X [63Z 2/ 5 4 =,
self.tip_target.set_position(self.initial_tip_positions)
# BT REZHFERRA/AEERTTE, UL EEHEREXTRE
self.pr.step(Q)
# BEFENER: B TEARMEHFERED, FrUNRE FESER R I 50 KA,
# NTLEEFEE, HUWETRHCE LED AT ERA — LB E
itr=0
max_itr=10
while np.sum(np.abs(np.array(self.agent_ee_tip.get_position()-
np.array(self.initial_tip_positions))))>0.1 and itr<max_itr:
itr+=1
self.step(np.random.uniform(-0.2,0.2,4)) # K FL AL 1E 3k 7 oF FAE 891500
self.pr.step(Q)

elif self.control_mode == ’joint_velocity’: # JointMode.FORCE
self.agent.set_joint_positions(self.initial_joint_positions)

self.pr.step(Q)

# B[R (collicable) #=, AT At M
self.gripper_left_pad.set_collidable(True)
# WERAFR N TAEN, AT A N A E

self.target.set_collidable(True)
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# WRREEE R, LTI

if np.sum(self.gripper.get_open_amount())<1.5:
self.gripper.actuate(l, velocity=0.5)
self.pr.step(Q)

return self._get_state() # L EIHE LFKA

WIHABISEE (OpenAl Gym %5) HEFEEHT stepO BE, EFHRAX BB B HE.
XA PR ZEAE LB EEAE AN« WAL A end_position BAfH H I 1112 3l 2% 45 il
% EEERHZE X _move() BRBURHATEIIE: WENLI AL B joint_velocity iz

T IE S E R, AU E RO A B T LB e

def step(self, action):
# REDEEHIME: wREHER Y joint_velocity’, AFER 7 FRAFTHEME +1
# R R AR EE; WwREEHIER N end_position’, MAFNER 3 FERME MARER L) (LE
# +1 fERERER

# et

done=False # F &%

reward=0
hold_flag=False # 7 @ 3= 41K B9 17 4
if self.control_mode == ’end_position’:

if action is None or action.shape[0]!=4: # & 1E2 & 4HE
print(’No actions or wrong action dimensions!’)
action = list(np.random.uniform(-0.1, 0.1, 4)) # KE#L

self._move(action)

elif self.control_mode == ’joint_velocity’:
if action is None or action.shape[0]!=7: # W% EHIEZ L 4LE
print(’No actions or wrong action dimensions!’)
action = list(np.random.uniform(-0.1, 0.1, 7)) # KHL
self.agent.set_joint_target_velocities(action) # #Lik/& #4721k
self.pr.step(Q)

else:

raise NotImplementedError
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B T REBHLME , 2205 K 5L (Reward Function) TRISCIRZS (Absorbing State ) 5 515 5 (done)
FHEAGAMCI IR R A IRAS G B 2@ step) BRESLI, WFFR. BIHPTE A
AL — N IEE, T A b v ST AR 5 2 — AN RO R N AR 38 IR i 1 — Fh A it 22 il
HUHI, T A] REX 2 e AR AR MESE 2] o BT AFRATTAR N 7 BE 55 b I3RS ORI B 5 > o XM &I
FE A AR ui AT 45 2 B AR BE RS, RIS FRATT AR 1] Je B 55 s i il ket o e BAIR . axX 4y
BT — AN R B SR, FRATTE T B AR 2 R AT B R R A AR S HARA tHON, T ERAT]
B H AR 2 b AU B AR4E . BT EE B AR T DUE L TR B AYMA R O IEE R, B2k A
AT REM BT AR G, TTIX AT B BN G 0d MUPURAS o 51 2 00 T IX M 42 il ek 480 5 Ak 2 ST
% HbrZ (B3 B US55 18 FEr )it it . T IXANER, A1 X 2L h o T E1E,
W E — ML T BAsiE BT A B i ORI E bR sD SREU B AR G, AT AERE
Ja LN AT AR B

ax, ay, az = self.gripper.get_position()
if math.isnan(ax): # #ILE X F L AR HEH R
print(’Gripper position is nan.’)
self.reinit()
done=True
tx, ty, tz = self.target.get_position()
sqr_distance = (ax - tx) ** 2 + (ay - ty) ** 2 + (az - tz) ** 2

# REFu B AR R BE B B

# £ KB SRR 5T B e B 5 A R B A I B B ok A R B
if sqr_distance<0.1 and self.proximity_sensor.is_detected(self.target)== True:
# FRINEZ FI & A 24T I8y
self.gripper.actuate(l, velocity=0.5)
self.pr.step(Q)
self.gripper.actuate(0®, velocity=0.5)
# WRERT, XARXE, 0 XA, 1 BT EE 0.5 7 UIHARRK AL DN XK
self.pr.step() # WIEHENZE a2 — &

if self._is_holding():
reward += self.reward_offset # I Z| 4k 41424 o
done=True
hold_flag = True

else:
self.gripper.actuate(l, velocity=0.5)
self.pr.step(Q)
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elif np.sum(self.gripper.get_open_amount())<1.5: # 1% k& B oy TA04E = LM 7 [H &
# <A (FRZAHT), T E; get_open_amount() K [E ¥k E x ¥ oy — L dEE
self.gripper.actuate(l, velocity=0.5)
self.pr.step(Q)

else:

pass
# EALBHEEEBFHNAE
reward -= np.sqrt(sqr_distance)

# MR EEZENEL
if tz < self.initial_target_positions[2]-self.fall_down_offset:
done = True

reward = -self.reward_offset

# MME S LB ENER
if self.gripper_left_pad.check_collision(self.table):
reward -= self.penalty_offset

if math.isnan(reward): # & 3% % {2 |7 7

reward = 0.

return self._get_state(), reward, done, {’finished’: hold_flag}

P 9% PATIASEE 14 R S30HF X i 2.2

def shutdown(self):
# K AEWE
self.pr.stop(Q
self.pr.shutdown()

FELUTF s, BATRM T LT LU E S R EEABE: BRI AL E R B E R Al
NI ALE AR A AL 1 T DA S B R LA NS 1075 2 HLas Nl 1k g sh A
RAZHN R SLI s HLas AR 2 T AUERES K, RS ALE . R B AR BN
W . (HAR R v LIRS S SO S B AL A%, Lol S i sl 2Ok fi L 8 AR
Sl E, ARG AT 2 T I IR i SO B 5 S B IRAS AR , fH SEADA5 2 AR
NG, BEBEES I E MmN R 5, 55,

404



162 &AFI A FEAMLS

FEWUH SCAEH, - Sawyer JIUBUE 55 AOFAE AT LU LA i 2K Ik -

python sawyer_grasp_env_boundingbox.py

16.2 sEUEIAHTHULEAES

IR EE TR I8 B A ] LS N SR — NSO I BE 1) 7 4EIELESE S A, LR
—AN 17 YEELDIREAS AR, BIUCAHEL T2 1058 5 BAIEE 6 B pl i s, X2 — MR ZRT
WEE. IR H, HLES NSRS R AR R A I R 75 SR A A IR ] o X A A5 i B 2 A
B FPLFEARHE SR A BT IR 8] A IR — AN AH G PR SR AR R o szt JRATTR I SRS 27 >0 3ok B (¥
FEEAET CoppeliaSim (V-REP) FIARLERE, Wik A A i Ree, s (5 % o) fgE
WARR . FRATFEEIFAT 1B 2RI ZRHE ZE oK MG XA 55 IR R AF I 2

FEXANTE o, A IRAT I3k Actor-Critic (Soft Actor-Critic, SAC) Hik, f F 258
13 Z I E T IFATHESE . SAC FIEITEA /M HAE S 6 &, AIRENE STk, BT U B i
TR IR I £ SAC S R AL AT #E . /B —Fh S 2k3KIE (Off-Policy) )5k, SAC ff
FXS i (Gaussian) SREESR R0 m4EIELE SR 0], I BB AE I ZR b b AR AR IR € 1 3R
WA E (Deep Deterministic Policy Gradient) 525 Infa e 3 BXf S8 & #E, JUHZRA T 05K
FRATIE RS ST 7775 (Haarnoja et al., 2018) 5. ‘B HRH F M Q-Learning (Soft Q-Learning)
RIEATHIIE WAL, X XG2S APUEIE S LIRSS R BT DR % . i&F, BT SACH
R 2 i 1) 2% 21 07 20, BT DU AR SE B H T DU T (5 M eSO AT RRAR

RUAER AT 7 IRAT ISR AEERE, RIS NBET L IH E SO B SR 2L R R — N I I AR TR 248
WARPRIAE, Gn S RS P AR g 2l W 2 e EoinsE . Oy 1 — DRk 2 21 i, FRATIXS 22 ol ek AT
Rk AR, T, B — Kok, BT EMKAEK T RAMIFEGEE, ik AR
RE T B 7 ) fff HL e B TR IR I, JF Bl IR R 2E0m R o Bk, FRATER s Lvsim 7 —
ANEAMFE T IR

# N AEHRREE: WRXESEFRERTHEER, X

# ERXELFRE ERFLATRA \pi/200277 1] A B £ 57+

desired_orientation = np.concatenate(([np.pi, 0], [self.target.get_orientation()[2]]))
# XEEHEFEA, FHEHHAT

rotation_penalty = -np.sum(np.abs(np.array(self.agent_ee_tip.get_orientation())-

E—AEFNBES

desired_orientation))
rotation_norm = 0.02

reward += rotation_norm*rotation_penalty

HR, A ERTA, K e B A 2 18] BE S 0 S B D 3 il pR K — B0 7T RE = S BUIE SR AR AR S HL
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Lo FrUlE A KR LB IR IE N B E H A O L — MR R A B AR A
ﬁ%,ﬁAﬁﬁ%ﬁ%%ﬂMT%m:

# WEMCENERER: BEALEMENERYERE EE T A A R
offset=0.08 # fmi%&
sqgr_distance = (ax - tx) ** 2 + (ay - ty) ** 2 + (az - (tz+offset)) ** 2

# KEMERLEERNFH

BT DA P Ao 22 R B R e, 22 S0 R A L TR 4R B 25 B sl IR 2R B B R A5 B i — D R
T+, K 16.8 fix.
P (WER2ER))

01
=
K
-10 F F F F F F + +
0 250 500 750 1000 1250 1500 1750 2000
_ ¥ St (BEERE)
:’\ -7.5
6 2.")0 560 7.")0 10‘00 12‘50 15‘00 17‘50 20‘00
B FI)ghsk (EREERR)
_25 4
gr ~501 /,_\/_/'b”’(N
E'l: —-7.5 1
(I) 2.")0 560 7.")0 lOIOO 12I50 15I00 17I50 20‘00
RIh
W o —  wEmzm
8 0051 E %é@i‘bﬂ
:]ﬁ 000 — a%%@%%ﬁb . | - . | _._'__,_,—/""
0 250 500 750 1000 1250 1500 1750 2000
YR ER
E 168 {F/8 SAC BEAF T ESawyertl g AIMBUESS B0 SR, R E 2 R ek £
EE%:

A Dl bR B R A SE R P — R A B NSRBI AR A B 2 2T iy 3, R X AT e S RHET
FAR G FVRRAFF, OSBRI BETE, AR S0V T 22 0 pR B T RE R AR &, DA
L H AT Be k22 ST OB, Ry S SC I N REA B SRS Sl R . LS, AESER
fif R —MESS, RELLL R — S AR BT ATRES IR # B B TR R TR, MR ZORTE
H2f SR SE R T — A R A ST ORI 3, WnsR 8 E iR
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16.2.1 FHiTi%

CoppeliaSim (V-REP) %/ 75 BAFAMBMIR B4 — AT (3R . R, A 7 IR e,
WATEE T 2RI S SA2 107 SR IEATICEREA . FRATHARAD P 1 T — 4@t PyTorch
I 2 HERR IR AT SAC Bk, LRIt it P vl LA B 32 A7 4 F -

# &
python sac_learn.py --train
#
python sac_learn.py --test

FERXAMCI RSS2 ARSI, RS — MBI .

16.2.2 ZF YR

FATIMR T SEAE Sawyer NHAES LRI, JFER 16.1 haath TR RIES .
ARCRIIE 16.8 i, WIE =R AR FESERF Rk E. 18] 16.8 HH R B2 )i o BT B4R —10 2 H
WA i S (0 R I 1 o AN TR PR 5 il R R S RV B F ST, e T S R {2
BEAT LT RERAN AT R CFIFRD JrBERIAh, FATIE IR 7 82 S R v I
JEIIE o BEA I ZREEAT, FATR LA AT 2D A F A AR ORI, X 7R HALAs AT
TERERIHED o 358 1R 2R i BR300 LU S i B 3 il o P 1 S 8 R N = >0 BROICR s Tt e i
KPR, RRANZE YU AT LR AT HER -

£R161 SACHBSH

S i1
itk s Adam (Kingma et al., 2014)
ST 3x104
L () 0.99
TAE# (workers) (& 6
FassZ 40 CGREE) 4
P e A () 512
Rtz % (Q MI45) 3
Rl S ocH (Q MIZ%) 512
R 128
ERYTIEN BIAE4E B I A
GeA7r R 1% 108
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Wk 16.9 Fios, £JLT A BNZRid e, Hlas N Cemeis h— € 1 H ARV R A Bk
IE, EP LS AR e BRI FREARR & AT, BRI RERMNLTT
9RO ARAAT A 7R T B SR

B 169 &gk, Sawyer AEARIIRE th ARE RS ST KBHBUAE (WR4E )

16.2.3 IEpENLIL

AR AR IA LT I 2515 2 S T BUSE b, i ISt 7 3 7 A I R AT A B
MIZES, XA RIS ARERT) o SRBENLIL R 08 SIS AL RE S —Fh 7k, JUHOR 2 BRA TR A
FUFRIFE o 27 27 1R SRS AT A% B B S S i

RBEALAL AT LS BE VLIRSS T R B S HOR ST, RIS s MU 3 0 22 S L 53
AL HE RS H . BARRY, BEVULPE S HOMES) 71 22BEHLIE (Peng et al., 2018), LL
i, WK TR HUBCE LTI . MR R SR I 2 (0] (B 4. I HL, AR T AR
i, DRI SEREER A A A B T AR REALAL, X e R 1 WAL & N R Bk
BEATRIRO R REAR . B, BATATBUM AR fir & 7 PyRep HH B E IR IIEE:

self.target.set_color(np.random.uniform(low=0, high=1, size=3).tolist())

# AEHERERE [r, g, b]3 HHEE

FABBADIA L s (Y B S B ] DOBAT HH R B, X B A B E . FE VIR e A, JRAT
A AEBEA I G 2 o s i Bl JL A B AT — IS B E R E . [N, EEMR, ER
UEXS AU IR 85 o B 7 2 2 ORI H A RS AE HEAT BE LA (130 BB 2L RE 0% 78 o I S b S i 3 2l
T 2 i RS 400 I S T i

S BEATL A 2 R AE B B I S 3 v 2 ik B
CoppeliaSim H1#EATHLERFAEBE AL R 5 B
MFRLESS 7 &

SEIE B — AT e 5 30, BLEAEA] PyRep £
R AMRET BB SC TR BB ST R 1T
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16.24 HESANFESIEME

FELL B N R, JRAT R T A R i — LA AT 55, I FH — A b 5 ) R R R E .
WK, SCHR (James et al., 2019b) #2H 7 RLBench # {4 48 (BEE2 W& IR S5), 1EN—ANE R 100 4
ST NN BET TR 45 I R L HE RN 2 ST 3R BT . IX AN 1T TR IS T DL A 4%
U TE, AR T fk 2% 2], 1 Baf LS T % 20 . 2415520 TUAT TSN LA A/
FEARZE2] . a0l 16.10 5 fr7x, RLBench 2 T8I JLYT BT PyRep, ‘B 1 100 NMEARKIHLE
NERAEATSS, IS 3. HERURIF At 224 1 B0 Sz th b i LA, SCRmdl o 7 B 9 1
BEPIRSIT S5 e A, FEAER A HE TR STTE N BIAS R 52 ) 751 AT DA SRAR DX AN R85 )
£

‘i'\‘?\‘?\‘i'\‘?\‘?\‘?\

16.10  RLBench B E X 891128 A% SIES ( WFIE )

AT LN A ARIALES NITEBUTE 5324t 7 — A H CoppeliaSim (V-REP) SZHUAR A5 L
NI WARHERESE, X HIEH T RLBench 8. EAIMEIHE D =AREAER. (D #
CoppeliaSim (V-REP) "3 TAE5 3 5 i e, (2) it A 8 SRS OE R, 45 reset
M stepQ BR%L, (3) I IASRHE—NReAE = I RelER, LA #% >J . RLBench 1#E1EiX
PR AR, H DL —Fh E IR I 25 1 R AB i AT 55

RLBench A m] LUl I DL T dr & K224 (IRIRC 4 %% 1 PyRep):

git clone https://github.com/stepjam/RLBench.git
pip3 install -r requirements.txt

python3 setup.py install --user

16.2.5 EHih1E#lzs

W 16.11 Fios, B2 AR N ISR, .45 OpenAl Gym. CoppeliaSim (V-
REP/PyRep) (James et al., 2019a; Rohmer et al., 2013). MuJoCo (Todorov et al., 2012). Gazebo,

sPE{% K H RLBench.

409



%16 % BEFEPMEAZES]

Bullet/PyBullet (Coumans et al., 2016, 2013). Webots (Michel, 2004). Unity 3D. NVIDIA Isaac SDK
Ao SEEH, X BB B A 0 T AN [F] R R A AN R R . 254515 3, OpenAl Gym robotics
IR — AR T BRI PR, AT AR SRR $2 4 ¥ 777%;  CoppeliaSim A Unity 3D #f5/2& 2% T4 31
RS, HAT M BT E P8R s MoJoCo A BN BLSL FIAER I B 51 88, ] LA T4
FII ST Isaac SDK A& — MHXTECH BB (T 2019 FFRAT), W FE 2 ] B RN A 5
SRISCRE, DA T Unity 3D MR B SETE Sy, 5%

1

1611 B8 AZIES: (1) OpenAl Gym & & FetchPush ( Z); (2) {8 PyRep LM B #r
FIA1ES (B ), RoboSuite 8y Sawyerlift £55 (& ) ( W¥4E )
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